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1. Scripting Concept

Automating Desktop and Other Applications

Although Automation Engine already offers a broad set of tools to create custom workflows,
it is still possible that you miss some functionality or that the available functionality does not
support the native graphics format that you want to run them on.

This is why Automation Engine also offers custom scripting: you can write scripts (small
programs) that typically represent actions that operators do interactively in their graphic
desktop applications..

Once you created that script, the Run Script task enables to insert that task into your normal
workflows. This is how you can automate your desktop applications.

Some examples:

+ To automate actions in desktop applications like Adobe Illustrator, Photoshop, InDesign
(Server), etc. (via ExtendScript on Mac Os and Windows).

+ To convert files into a format that Automation Engine tasks support. For example converting
non-PDF compatible Al files into PDFs.

. Attention: Itis up to the user to verify that his intended use of the offered automation
functionality is compliant with any third party license agreement and/or other
restrictions applicable to any non-Esko products.

Supported Script Types

+ AppleScript (Mac)

+ ShellScript (Mac)

« Batch files (Windows)

+  Windows Script (VBScript, JScript) (Windows)
+ ExtendScript (Mac and Windows)

1 Attention: When scripting Adobe applications, the Script Runner tool on Windows
does no longer support 32 bit versions of those applications.

The Script Runner Tool

Executing such scripts starts in the Run Script task. One of the settings in that task is to choose
if the script will be executed by a separate Script Runner tool (that you installed earlier on a
Mac or Windows client computer), or if the script can run on the Automation Engine server
itself (in an on-board 'script runner’).

When, for example, your script is a Windows batch file, it will be possible to run it on the
Automation Engine server itself. But when the script needs to interact with a Mac (Adobe)
application, it will require help from a standalone Script Runner that you also installed on that
Mac.

Learn more in The Script Runner Tool on page 5.
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Extra Information and Tips available as KB articles

Because the area of scripting is often about customization, the examples in this documentation
do not cover all use cases.

We therefor advise to also check Esko's Knowledge Base for articles on this topic.


https://www.esko.com/en/Support/Documentation/
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2. The Script Runner Tool

The Automation Engine does not actually run your custom script: the task communicates with
an Automation Engine Script Runner.

ﬁ Attention: As mentioned in Scripting Concept, the 'Run Script' task can run the script on
the AE server itself (a Windows Script or batch file) or it could use a standalone Script
Runner tool on a Mac or Windows client.

Here 's an overview of the workflow when a standalone Script Runner tool is used:

AE Server

ij starting @
——— g ———=
o

Run Script

®//® @\C?
£

AE Script AE Script
Runner Runner

1. The Run Script task sends a request to run the selected script on its input file(s). The task
can communicate optional script parameters and also defines the output folder for the
resulting file(s).

The selected Script Runner processes the request and runs the script.

The Script Runner sends the results back to the Run Script task.
4. The workflow continues with the outputs from this Run Script task.

Ma:

)
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3. Installing Script Runner

Follow these steps to install the Script Runner tool
1. Go to the Automation Engine Server Web page, section Client Apps > Tools and Download
Automation Engine Script Runner.

2. After downloading, double-click the ‘dmg’ file (Mac) or the 'exe’ file (Windows) to start the
installation. Follow the instructions in the Assistant (Mac) or Installshield Wizard (Windows).

3. Check the tool's preferences to make sure it is running on that computer:

+  On Windows, open Start > All Programs > Esko > Automation Engine Script Runner >
Preferences.

+ On Mac, open Applications > Automation Engine Script Runner > Esko > Automation
Engine Script Runner > Script Runner Preferences.

In the Script Runner Preferences dialog, you can:

« Start / Stop the Script Runner (or just check if it is running).

Note: On Windows, this will run the Script Runner as a 'Service'. Learn about (the need
for) other methods in Adobe Applications on Windows: Run Script Runner as an Application
(Not as a Service) on page 33.

+ Enable / disable Start at login
+ View / change the Port that the Script Runner is communicating with

+ View / change the default folders for (types of) scripts.

Example (on Windows):

Start | Script Runner is not running.

| Start at login

Port:{ 1983
Batch File Folder: C:\Esko\bg_data_fastserverscrrunnt_vw100\Scripts\Batch | Browss
ExtendScript Folder: ko\bg_data_fastserverscrrunnt_v100\Scripts\ExtendScript | Browse
Windows Script Folder: \bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript | Browse

wWindows Script (32-bit) Folder: \bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript | Browse

/. Attention: The above shown folders are local, on the Script Runner computer.
Learn how you can (also) store them centrally in Configuring Script Runner on page
7.
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4. Configuring Script Runner

The Automation Engine server needs to know where your Script Runner tool(s) were installed.
You could for example have 2 Macs dedicated to run scripts and also have the Automation
Engine server itself have some Windows scripts or batch files running.

1.

Install Script Runner on the client computers that will run scripts. Learn more in Installing
Script Runner on page 6.

In a Pilot, go to Tools > Configure.
Go to the category Scripts.

Now define which computers will run the scripts. Press Insert or choose File > New to add
one.

£1 Configure lEM

File Edit
# Create DCS Master ~
t 4 Digital Press Host: EAW11DL306
# E-mail Configuration
+-# External Databases Port: 1983
+-#% External Web Services T ——
# FastImpose Site Preference Test Connection
H-4 FlexProof - Image DownlLoi -
+-4& FlexRip - Approval
+-4% FlexRip - B Available Scripts on EAW11DL306:
+-# FlexRip - BI |
R D ||
H XD - ompa ExtendScript EskoAlPrint.jsx
% Flextip - CDI Spark 50 | |ExtendSaript EskoIDDPrint.fsx
% FlexRin - Proofer Dutput ExtendScript EskoIDDSaveAsPDF isx
-4 FlexRip - Screened Output ExtendScript EskolDServerPrint.jsx
7l FlexRip - Unscreened Outpt ExtendScript EskoIDServerSaveAsPDF.jsx
# Gang Run Printing ExtendScript EskoPSDoActionAndSaveAsIPG.jsx
% Global Vision —| |Windows Script EskoAcroCallJSFunction.vbs
+-# Imaging Engines —
+-#% Jobs
r g Hgi:(iltj‘liation Available Scripts on Automation Engine:
+-4% Odystar
-3 Pack Proof Servers Type ~ Name
P.g ngﬂtiiahll\-—'lrotﬂlsd Batch File SDeC_?lumbEI“s_FI'Om_Nestinq_REDOI'f.bat
rinting Methods ExtendScript Applnfo.jsx
% Processing Preferences ExtendScript EskoAIHelloWorld.isx
-+ # Products ExtendScript EskoAlPrint.jsx
T i itan04 ExtendScript EskoIDDPrink.jsx
o oo 1L 306 ExtendScript EskoIDDSaveAsPDF jsx
# Shutfle = ExtendScript EskolDSarverPrint.jsx
# Track Edit Session ExtendScript EskoIDServerSaveAsPDF.jsx
| # Viewer ExtendScript EskoPSDoActionAndSaveAsIPG - New.jsx
|' 3 Web Proxy ExtendScript EskoPSDoAcdtionAndSaveAsIPG.jsx
F-#& WehCenter Sites ExtendScript MyHelloWorld.isx
ExtendScript Save as PDFs.jsx
4 I 7

Give a suitable name to that Script Runner. Press F2 or choose File > Rename

In the Host field, enter the computer name or IP address of the Script Runner computer.
Enter the Port used to connect this computer to your Automation Engine server.

By default, this is 1983.

Click Test Connection. You should now see a list of all available scripts on that computer or
see a message 'No scripts available'.

These are the scripts that the Run Script Task will let you choose from when you have
selected that Script Runner configuration.
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You can store script on a local (Script Runner) client or centrally on the Automation Engine
server:

Local: You can store scripts on your local client computer on the folder specific for script
type. But note that Automation Engine does not back up these local scripts. It can be
useful however to only have them local when you are still writing and testing a script or
when you do not intend to give access to other Script Runners in your network.

Note: The default location on a client computeris /Library/Scripts/Esko (Mac)and
C:\Esko\bg data fastserverscrrunnt v100\Scripts (Windows).

Central: Alternatively, you can store your scripts in a central Automation Engine system
folder. This option is suitable when you want to make your scripts available to all
configured Script Runners. They will then also be part of your Automation Engine
backup.

Note: The default location on the AE server is C: \Esko
\bg data fastserver v100\Scripts. The subfolder names indicate the type of
script.

9. Choose Save (from the menu of the Configure panel).

10.Select the Configure category Scripts (not a configured item, but one level higher). On this
level you see a dialog where you can choose Download Scripts to download all scripts
from all configured Script Runner tool(s) and centralize them onto the Automation Engine
server. This is done to have a central library that will also be part of your server configuration
backup.

Note: You will be asked to confirm when local scripts would overwrite central ones.
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5. The Run Script Task

Note: Learn about the concept and the setup of custom scripts in Scripting Concept on page 3.

This task contacts a Script Runner tool to run a script on the input file(s).

>

- Outputin: | [Job URL] foutput Browse | []
Runon: | Automation Engine w | Configure...

Script Type: _ExtendScript - |

Application: |Adobe Illustrator -

Script File: |EskoPSDoActionAndSaveAsIPG.jsx [1 ~

Script Parameters:
Molten Lead
Default Actions

Add Remove

1. Run on: Choose the Script Runner item that you configured in the Configure panel.

2. Select the Script Type. The types are different, depending if the selected Script Runner runs
on a Mac or a Windows computer:
a) For Mac: You can choose from AppleScript, Shell Script and ExtendScript.
b) For Windows: You can choose from Batch File, ExtendScript, Windows Script and
Windows Script.

From version 16.1, you can only install the Script Runner tool on a 64 bit host, but you
can still run 32bit Windows scripts by specifying the script type as 'Windows Script (32
bit)'.
3. Select the Application. This field helps to find the right application, especially when you
have multiple versions installed. The drop down list is a default list that you can edit.

+ On Mac: this is the (original) name of the .app file of that application

+  On Windows: the "Target location" that appears when you ask the "Properties" of that
application. An example:

Tl Adobe Photoshop CC 2014 (32 Bit) Properties o ]

Gengral| Shorlcut Collpaﬁtxlity:SBcurlyl Destails | Previous Viersions

ﬁ Adobe Photoshop CC 2014 (32 Bit)

Target type: Application

Target location | Adobe Photoshop CC 2014 (32 Bit) |

Target dobe Photoshop GG 2014 (32 BityPhotoshop. e

Start in "G\ Program Files (xB8)Adobeihdobe Photoshop O
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Tip: Itis possible that you do not have to enter the full name, but minimally the part
that will help the task to recognize which of the multiple versions you want. For example
when you both have a CS and a CC version, then the year and the bit version do not have
to be mentioned extra (because those are only mentioned after the 'CS' or 'CC' part).

4. Select the Script File. You can select one from the drop-down list, enter a path or/and use
SmartNames.

5. When the script needs one or more optional parameter(s), enter them in Script
Parameters. Click Add and type the parameter.

Note: Learn more details and see some examples in the next pages.

10
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6. Scripting on Mac OS

6.1.

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These
scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results
in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any
non-Esko products.

AppleScript - Example 1

AppleScript is a scripting language that enables direct control of script-able applications and of
many parts of the Mac OS. An AppleScript-able application is one that makes its operations and
data available in response to AppleScript messages, called Apple events.

We recommend using AppleScript because:

+ itis highly integrated into the Mac OS
« itis supported by a lot of third party applications
+ it very accessible to scripting beginners.

1. Open the AppleScript Editor and add following code:

|]_

®NO Untitled

= — N

Qe®w N =
Record Stop  Run Compile Bundle Contents
AppleScript : <No selected element>

on main(inputs, outputFolder, params)
log "Hello, Worldl"
return "OK"

end main

-

[ Description |-EventLog ]

Option Description

main This function will be called by the Script Runner. Only the code in
this main function gets executed.

11
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Option Description

inputs The first argument of the main function: a list of input file paths
(type: list of strings).

outputFolder Second argument of the main function: the folder where AE expects
the script’s result files. AE will continue the flow with the files you
write in this folder. If you leave this folder empty, AE will continue
the flow with the inputs of the Run Script task (type: string).

params Third argument of the main function: additional script parameters
injected into the script via the Run Script ticket (type: list of strings).

log Extra log information in the Run Script task details.

return “OK” This will communicate to the Run Script task that everything went
fine. Other possibilities are return “Warning” and return
“Error”.

2. Save this code as an AppleScript text file in the Script Runner’s AppleScript folder (default: /
Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

Save As: MyHelloWorld.applescript E]
[ «|»aa|=| I]]]] | (] AppleScript '#] Q,
DEVICES (] ColorSync [ AppleScript -
£ Mac HD m: [] Esko > m [ ExtendScript
F iDisk o m ] Folder Action Scripts ] Shell
- ] Folder Actions
SHARED " I_—l Font Book "
PLACES ¥ [ FontSync Scripts 3
B [ I
A Deskeop ; e i
File Format: | Text e ]
Line Endings:  Unix (LF) >
Options: | Run Only || Startup Screen
__| Stay Open
" Mow Ealdar
[ MNew Folder ) (" cancel ) ( Save )
s

Note: Script Runner supports ‘Text' format. Therefore it is essential to change the file
format to ‘Text'.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file
and click Run to execute the script.

12
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on main(inputs, outputFolder, params}
log "Hello, World!"
return "OK"

end main

on run
== Our main function is not using any of its
arguments, so provide empty ones
set inputs te {} -- empty list
set outputFolder to "" -- empty string
set params to {} -- empty list
main{inputs, outputFolder, params)
end run

[ Description M

on main(inputs, outputFolder, params}
log "Hello, World!"
return "OK"

end main

on run
-- Our main function is not using any of its arguments, so
provide empty ones
set inputs to {} -- empty list
set outputFolder to "" -- empty string
set params to {} -- empty list
main{inputs, cutputFolder, params}
end run

[Events ) | Result

(*Hello, World! =}

Result:
"OK"

[ Description M

Notice the ‘Hello, World!" and ‘OK' result in the event log. The Script Runner does not
interpret the test code in your script. It will execute the contents of the main function and
ignore the rest. You can keep any test code for future local testing.

4. In the Pilot, go to Files view where you can select a file and open a New Task. Choose the
Run Script task, modify its settings and launch the task.

13
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Settings for Step: Run Script
Qutput in: BEROWSE J§]

a

File Name:

Run on: | My Mac Script Runner |

4k
L

Script Type: [ AppleScript 5 ]

Script File: MyHelloWorld.applescript [1 :]

Script Parameters

Learn more in The Run Script Task on page 9.

Note that the ‘Hello, World! in the task details and ‘OK’ state correspond with 1og “Hello,
World!”’ and ‘return “OK”’ inthe script.

saOe Tasks (RunScriptDema)
= | &3 BB | RunScriptDemo NE) Q-
Made Job MNew Job Search
v VIEWS Job Name File Mame Task Type Progress State  Launched w| TaskID
[ Fies RunScriptDemo Blairon_PDF.pdf Run Script 100% | | /23712 3:56 PM 3452
[#] To Do List
;—; Pages lask Type: Run Script ,—
= Started on Server: bégezingem =
g1z Products Started ak 5/23/12 3:56 BM
Lig Proofs Finished at 5/23/12 3:56 PM
E] WebCenter Process Time: 0:00:00
] Plates The scrint's standard output stream:
71 epi Hello, World!
- '_i The script's error cutput stream:
~m] Tash: <none>

7 Milestones

11 Tickets

6.2. AppleScript - Example 2

In this example, we use AppleScript to copy every input file with a size smaller than the
size specified in the script parameters to the output folder. To do that, we use inputs,
outputFolder and params in the AppleScript.

First, we illustrate how to duplicate files without the size restriction and then we proceed with
the actual case.

1. Open the AppleScript Editor and add the below shown code. This code is aimed to iterate
through the list of inputs. It enables you to handle the inputs one by one, via the ‘input’
variable.

14
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- YoXé) Untitled = |

on main(inputs, outputFolder, params)
== Iterate through the list of inputs
repeat with input in inputs
== Add code here to handle each input
end repeat

return "OK"
end main

Events Replies | @D

[ Description M

4

2. You can modify the Script as shown below to duplicate the files to a specified output folder
without size restrictions. Save this code as an AppleScript text file in the default AppleScript

folder of Script Runner (default: /Library/Scripts/Esko/AppleScript) or in the Automation
Engine AppleScript folder.

Xe)e MyDuplicate.applescript =)
® '

AppleScn'pt 4 =No selected element:> L.
on main(inputs, outputFolder, params}

== Translate the output folder (UNIX path} into an AppleScript file reference
set outputFolderReference to POSIX file outputFolder

-- Iterate through the list of inputs

repeat with input in inputs
== Translate the input (UNIX path} into an AppleScript file reference
set inputReference to POSIX file input

== Duplicate input to output folder

tell application "Finder" to duplicate inputReference to outputFolderReference with
replacing
end repeat

return "OK"
end main

Events Replies | LD

"OKR"

[ Description M

3. Add the file size check in the code as shown below. This will duplicate the file when the
input file size is smaller than the maximum size from the script parameters. If this condition
is not met, it will add an entry in the log and there will be "Warning". Save the file.

15
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@00 " MyDuplicate.applescript =

on main{inputs, outputFolder, params)
set returnValue to "OEK"

-- Translate the output folder (UNIX path) into an AppleScript file reference
set outputFolderReference to POSIX file outputFolder

-— Get the maximum size from the script parameters and convert from
megabyte to bytes
set maxSize to (item 1 of params) * 1000000

-- Iterate through the list of inputs

repeat with input in inputs
== Translate the input (UNIX path) into an AppleScript file reference
set inputReference to POSIX file input

-- Get the size of the input
set inputSize to size of (info for inputReference)

-- Check wether the input is OK to duplicate
if ipputSize < maxSize then
-- Duplicate input to output folder
tell application "Finder" to duplicate inputReference to
outputFolderReference with replacing
else
log input & is too big to duplicate"”
set returnValue to "Warning"
end if
end repeat

L]

return returnvalue
end main

-

[ Description |-Enli-l.ng-i

4

4. In the Pilot, go to Files view, select the files to be copied and open a New Task. Choose the
Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job's Script Output folder. In this
example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

16
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Settings for Step: Run Script
Output in:  [Job URL]/ScriptOutput

BROWSE 8]

File Name:

N
3

Run on: | My Mac Script Runner

MyDuplicate.applescript

Script Type: [ AppleScript

G|

Script File:

Secript Parameters

‘SmallLabel.pdf’ is duplicated into the job's 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in a ‘Warning' state and added an entry in the
task details.

s

| a Files (RunScriptDemao)
= - B IR a
Mode Job New Job Search
¥ VIEWS |v [ RunScriptDemo Name 4 View | Type Size | Date
- » [ Artwork 1 SmallLabel.pdf View PDFFile 89KB 2/10/10 2:16 PM
To Do List > B Esko No
@) Pages > & scriproutput Favorites
EE Products
°| Proofs
[H] begezing: ~ =3 MylobContainer = k] RunScriptDemo = (] ScriptOutput
WebCenter -
@ Plates File Mame Task Type Progress Phase State Launched TaskID
i col BigBox.pdf,SmallLabel.pdf Run Script 100% M f5/31/12 12:36 PM 3781
Tasks o m
Milestones Task Type: Run S.c"m
Started on Server: begezingem
{7 Tickets Started at: 5731712 12:36 PM
¥ TOOLS Finished at 5731712 12:36 PM
[+7] Devices — 0o
. .
Queue Monitor The script's standard gutput strea.m. ) - . .
_ /Volumes/MyjobContainer/RunScriptDemo/Artwork,/Bigdox.ndf ' is too big to duplicate
L Containers The script's error output stream:
3% Customers <none>
&, Users _—éI
| Hot Folders
Mew Task New Workflow  Info
1 file Server: begezingem User: admin 0 &

17
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6.3. Shell Script - Example

18

In this example, we use a Shell Script to copy every input file with a size smaller than the
specified size in the script parameters to the output folder.

1. Open a text editor and add the below shown code. When the Script Runner executes this
code, $1 (the script's first argument) will contain a string of input file paths separated by :
. The code splits up the concatenated file paths into a real list. This helps to iterate through
the list and handle the Run Script task’s inputs one by one.

® MO, @ untitled text —]

o TH 'Q::f (New Document) |'PL
- untitled text > -

]

#!/bin/bash

# Split up the input file paths into a list

# via the Internal Field Separator (IFS)

OLDIFS=3IFS # Always keep the original IFS

IFS=":" # Now set it to ":'

# Split up "$1' into the 'inputs' variable, with ':' as separator
inputs=( %1 )

IFS=$0LDIFS # Restore the original IFS

inputCount=%{#inputs[@]}

# Iterate through the list of inputs
for (( i=0; i<${inputCount}; i++ )J;

do
# Add code here to handle each input
done
exit @
&) <>
201 (none) % |Unicode (UTF-8) 3 |Unix(LF) % [ 44372/ 20

2. Write the code as shown below. This script copies the input to the output folder if the
input’s file size is smaller than the maximum size from the script parameters. If the size of
the file is bigger, it adds an entry in the log and makes sure the task ends in ‘Warning’ state
(via exit value ‘1"). Save this code as a text file to the Script Runner's Shell folder (default: /
Library/Scripts/Esko/Shell) or to the Automation Engine Shell folder.
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= |

i 1 R d?] = Last Saved: 19/06/12 10:04:19
L/;P \F'['_Inv @ ":_J File Path w : jLibrary/Scripts/Esko/Shell/MyCopy.sh

Y MyCopy.sh =
#!/bin/bash

# Split up the input file paths into a list
# via the Internal Field Separator (IFS)
OLDIFS=%$IFS # Always keep the original IFS
IFS=":" # Now set it to ":'

B—l

o, W # .
-

# Split up '$1" into the 'inputs' variable, with ':' as separator

inputs=C %1 )
IF5=%0LDIFS # Restore the original IFS

inputCount=%{#inputs[@]}

# Get the output folder
outputFolder=%2

# Get the maximum size from the script parameters
# and convert from megabyte to bytes
maxSize="expr $3 \* 1000000°

exitValue=0

# Iterate through the 1list of inputs
for (( i=0; i<${inputCount}; i++ )J;
do
input=%${inputs[$i]}
# Get the size of the input
inputSize="1s -1 "$input" | awk "{print $5}'°

# Check wether the input is 0K to copy

if [ $inputSize -1t $maxSize ]; then
# Copy input to output folder
cp -f "$input” "$SoutputFolder"

else
echo "$input is too big to duplicate”
exitValue=1

fi

done

exit $exitValue

|
e

40 1 Unix Shell Seript % | Unicode (UTF-8) = Unix (LF) % |7 892/ 140/ 40 A

$1

file paths, separated by "'

First Shell Script argument: the Run Script task’s inputs. A string of input

$2

Second Shell Script argument or output folder: This is the folder where
Automation Engine expects the script's result files. AE will continue the
flow with the files you write in this folder. If you leave this folder empty,
AE will continue the flow with the inputs of the Run Script task.

$3, 54, 85, ...

Remaining Shell Script arguments: additional script parameters which
you can inject into the script via the Run Script task.
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exitvalue Ending Status of the task
0 OK

1 Warning

2 Error

3. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch. This modified ticket will duplicate every selected file which
is smaller than 10MB to the current job's Script Output folder. In this example, we executed
this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

Settings for Step: Run Seript

Qutput in:  [Job URL]/ScriptOutput BROWSE W]
File Name:
o
Runon: | My Mac Script Runner |3 ]
Script Type: | Shell Script B
Script File: MyCopy.sh [1 j

Script Parameters

‘SmallLabel.pdf’ is duplicated into the job's Script Output folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state (due to exitvalue=1 in the

code) and added an entry in the task details.
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Files (RunScriptDemo)

| RunScriptDemo s [ emm | Q D

Job New Job Search

To Do List

@ Pages

EE Products

Proofs
@ WebCenter

E Plates
] con
Tasks
Milestones
I} Tickets

¥ TOOLS
|E| Devices
Queue Monitor
E Containers
3% Customers
L Users
(| Hot Folders

¥ VIEWS ¥ [l RunScriptDemo Name 4 view | Type | Size | Date
» [ Artwork ) SmallLabel .pdf View PDFFile 89KB 2/10/10 2:16 PM

» [ Esko No
» [ Scriptoutput Favorites

(=] begezing: = =3 MylobContainer * o] RunScriptDemo = (] ScriptOutput

File Name | Task Type | Progress | Phase | State | Launched | TaskID
BigBox.pdf,5mallLabel.pdf Run Script 100% M 5/31/12 12:36 PM 3781

Task Type: Run Script
Started on Server: begezingem
Started at 5/31/12 12:36 PM
Finished ac 5/31/12 12:36 PM
Process Time: 0:00:00

The script's standard output stream:
{Volumes/MyJobContainer/RunScriptDemo,Artwork/BicBax.pdf is too big to duplicate
The script's error output stream:

<none>

P

2y &) @

New Task @ NewWorkflow Info

1 file Server: begezingem User: admin [ 0 @ﬂ
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7. Scripting on Windows

A Script Runner on Windows supports Windows Scripts and Batch files. We recommend
Windows Script for its scripting abilities comparable to batch files, its wider range of supported
features and the simpler syntax. Windows Script is plain-text VBScript or JScript which is
interpreted and run by the Windows Script Host.

Note: Sample scripts are provided as-is with no warranty of fitness for a particular purpose.
These scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results
in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any
non-Esko products.

7.1. Windows Script Example 1

22

1. Open a text editor and add the below shown code:

@" "new 1- Notepad++ l =HRE &1
Eile Edit Search View Enceding Language Settings Macro Run  Plugins Window 2 X

PREEN = R =RERIrg =1 Do il x| BE|= '—J -
Eﬂnew1]

Function Main{inputs, outputFolder, params)
W5cript.Echo "Hello, World!™

' Set the function's return value.

[ (T Y S U

Main = "QE"
8 End Function

length:148 Ln:6 Col:39 Sel:0 Dos\Windows ANST INS
Function The function that will be called by the Script
Main Runner. Script Runner executes only the code in

this main function.

inputs First argument of main function: a list of input file
paths (type: list of strings).

outputFolder| Second argument of the main function: the folder
where AE expects the script’s result files. AE will
continue the flow with the files you write in this
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folder. If you leave this folder empty, AE will
continue the flow with the inputs of the Run Script
task (type: string).

params Third argument of the main function: additional
script parameters injected into the script via the
Run Script ticket (type: list of strings).

WScript.Echo| This puts some extra log info in the Run Script task
details and log. This call prints text to the Console
and adds a newline character without Script Runner
context.

Main = “OK” This communicates to the Run Script task that
everything went fine. Other possibilities are Main =
“Warning” andMain = “Error”.

2. You can test this script locally by adding the code shown below. Save this file. Open
command prompt. Change the directory to the script’s parent directory. Run command
‘cscript MyHelloWorld.vbs'.

-
PE\MyHelloWorld.vbs .. 0| ). e
File Edit 5earch View Enceding Language Settings Macro Run  Plugins Window 2 X
[ = [ = ] A Al = »
o JE]EGemBJlaanDla} |ﬁll *&|"3‘3|'—i'—‘.| J-Lj
= MyHelloWord vbs l
2
zZ Function Main({inputs, outputFolder, params)
4 WScript.Echo "Hello, World!"™
& ' Set the function's return value.
7) Main = "CK"
8 End Function
10 ' Cur main function is not using any of its arguments,
11 ' so provide empty ones.
12 Dim inputs()
13 Dim cutputFolder
14 Dim params()
1L Main inputs, outputFolder, params
16 |
i 1] 3
length:314 Ln:16 Col:1 Sel:164 Dos\Windows ANSI INS
|

This will produce the output ‘Hello, World!' to the console. The Script Runner does not
interpret the test code in your script. It will execute the contents of the main function and
ignore the rest. You can keep your test code for future local testing.

3. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.
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Settings for Step: Run Seript

Qutput in: 'BROWSE JW]
File Name:
a
Run on: | My Win Script Runner |5 ]
Script Type: | Windows Script e ]
Script File: MyHelloWorld.vbs [1 :i

Script Parameters

Note that the ‘Hello, World!" in the task details and ‘OK’ state are corresponding with
WScript.Echo “Hello, World!” andMain = “OK” in the script.

amo Tasks (RunScriptDema)
E . | [ RunScriptDemo = ] [ +m ] Q-
Mode Job New Job Search
¥ VIEWS | Job Name File Name Task Type @ Progress Phase | State Launched v| Task 1D
) Files RunScriptDemo  Blairon.pdf  Run Script  100% [l | 6/6/12 11:07 AM 3865 |
To Do List Task Type: Run Script
Ea Pages Started on Server: begezingem
2 products Started at: 6/6/12 11:07 AM
Proofs Finished at: 6/6/12 11:07 AM
Process Time: 0:00:00
WebCenter .
The script's standard output stream:
@ Plates Microsoft (R) Windows Script Host Version 5.8
E ol Copyright (C) Microsoft Corporation. All rights reserved.
"'-'j"'_-“”—""'-""l" Hello, World!
T The script's error output stream:
] Tickets <nones>

1 of 1 selected Server: begezingem User: admin 0

7.2. Windows Script Example 2

In this example, we use Windows Script to copy every input file with a size smaller than the size
specified in the script parameters to the output folder. We use inputs, outputFolder and
params in the script to achieve our objective.

First, we illustrate how to duplicate files without the size restriction and then we proceed with
the actual example.

1. Open a text editor and add the below shown code. This code is aimed to iterate through the
list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.
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IE‘T *new 2 - Notepad++ 1 E@gw

e 3

Eile Edit Search View Encoding Language Settings Macre Run  Plugins  Window 2 X
> T = = | = *»
cHEHBzGE smMDoe|ihyl 2tz RBRE|I=1ES
= new 2 |
2 HFunction Main(inputs, outputFolder, params)
4 r ' Iterate through the list of inputs.
5 H For Each input In inputs
6 r ' Add code here to handle each input.
7 Hext
9 ' Set the function's return value.
10 - Main = "OH"
11 End Function
| |
1 i 3
length:257 Ln:10 Col:16 Sel:0 Dos\Windows ANSI INS

2. You can modify the Script as shown below to duplicate the files to a specified
output folder without size restrictions. Save this code as a text file with ‘.vbs’
extension (VBScript) in the Windows Script folder of Script Runner (default: C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript) or in the Automation Engine
WindowsScript folder.
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T CAEsko\bg,data MyCopywbs - Notepad++ (s o0 e
File Edit 5earch View Encoding Language Settings Macre Run  Pluging  Window 7 X
cHEHE R LElsimD|ecinhl 22 BEIZITIED 97
= MyCopy.vbs |

1
2 ElFunction Main(inputs, outputFolder, params)
= "
4 - ' Create the file system object that is going to do the copying.
& Dim filesys
& S5et filesys = Createlbject("Scripting.FileSystemlbject™)
T 3 WScript .Echo "File system object created"”
B8
9 - ' Iterate through the list of inputs.
10 B For Each input In inputs
11 ' Copy input to output folder.
12 - Dim outputFile
13 outputFile = outputFolder & "\" & filesys.GetFileName (input)
14 B filesys.CopyFile input, autputFila
15 Hext
16
17 ' Set the function's return value.
18 7 Main = "CK"
o End Function
20
4 | I | 3
length: 578 lines:20 Ln:14 Col:43 5el:0 Dos\Windows ANSI M5

3. Add the file size check in the code as shown below. This will duplicate the file when the
input file size is smaller than the maximum size from the script parameters. If this condition
is not met it will add an entry in the log and there will be "Warning". Save the file.
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F B
g *C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript\MyCopy.vbs - Notepad++ @M
File Edit 5earch View Enceding Language Settings Macro Run  Plugins Window 2 X

5 ey =3 =
cHEB LB iRl tx B EREER 7
=] Mﬁhpyybsl
2 EEhnctian Main(inputs, outputFolder, params)
3 = Dim returnValue
1 returnValue = "CQE"
5
& ' Get the maximum size from the script parameters

' and convert from megabyte to bytes.
Dim maxSize
maxS5ize = params(0) * 1000000

F
U T+ & -1

- ' Create the file system object that is going to do the copying.

Dim filesys
S5et filesys = Createlbject("Scripting.FileSystemCbject™)
= WScript.Echo "File system object created®

- ' Iterate through the list of inputs.

I I R R
-] MmN s R

Hext

[T VT

' Set the function's return value.

[}
r

Main = returnValues
End Function

1 = For Each input In inputs

18 ' Turn the input path into a file cbject.

19 Dim inputReference

20 Set inputReference = filesys.GetFile (input)

21

22 ' Check wether the input is CE to copy.

23 B If inputReference.3ize < maxSize Then

24 ' Copy input to output folder.

25 Dim outputFile

26 outputFile = outputFolder & "\" & filesys.GetFileName (input)
27 - filesys.CopyFile input, outputFile

28 B El=e

29 WScript.Echo input & " 1s too big to copy"”
30 - returnValue = "Warning"

= B End If

-1 o

4 [0 | 3

length : 1046 lines: 37 Ln:31 Col:15 5el:0 Dos\Windows ANSI M5

4. In a Pilot, go to Files view, select the files to be copied and open a New Task. Choose the
Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s 'ScriptOutput' folder. In this
example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).
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Settings for Step: Run Script

Automation Engine

EROWSE JN]

Cutput in:

File Name:

a

Run on: [ My Win Script Runner

Script Type: [ Windows Script

Job URL]/ScriptQutput

B

L8

B

—
ERYE

Script File:

MyCopy.vbs

Script Parameters

4+ | =

1=

‘SmallLabel.pdf’ is duplicated into the job's 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning' state and added an entry in the

task details.

800
== K

Files (RunScriptDemo)

3% Customers

[ RunScriptDemo

i] [-w] (Q

View | T...

¥ VIEWS ¥ L] RunScriptDemo 3 Size Date
. T » [ Artwork ) SmallLabel.pdf Wiew P.. 89KB 2/10/... No
. : > Esko .
To Do List - Favorites
) Pages » [ SeriptOutput
9 products (=] - 3 My = ] RunScriptDemo = [] ScriptDutput|
= -
Proofs File Name Task Type Progress Phase 2 Launched Task ID
- BEB/&XTH.df' ... _Run Script 100% : @_ 6/6/12 4:2... 3866
] Plates Details
@ <ol Task Type: Run Script n
y | Started on Server: begezingem
Tasks Started at: 6/6/12 4:27 PM
Milestones Finished ac 6/6/12 4:27 PM
7 Tickets Process Time: 0:00:00

| The script's standard output stream:

¥ TOOLS ' ! : .
Microsoft (R) Windows Script Host Version 5.8
(7] Devices Copyright (C) Microsoft Corporation. All rights reserved.
Queue Monitor
E Containers File system object created

\\begezingem\MyJobContainer\RunscriptDemo’\ Artwork\Bj qu(_pdf is too big to copy
The script's error output stream:

‘ <none
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7.3. Batch File Example

In this example, we use a Batch file to copy every input file with a size smaller than the size
specified in the script parameters to the output folder.

1. Open a text editor and add the below shown code. This code is aimed to iterate through
the list of inputs. It enables you to handle the inputs one by one, via the command 1 (the
script’s first argument) will contain a string of input file paths, separated by ;.

G w1 et R R [
File Edit 5earch View Encoding Language Settings Macre Run  Pluging  Window 7 X
cHHB Al mbDiaeinyl t BRI 1EINCERRE 7
= new 1 |
1 Gecho off
2 rem First script argument contains the input file paths
2 set inputs=%1
4 rem Trim surrounding quotes
5 for /f "usebackg tokens=*" %%z in ('%inputs%') do set inputs=%%i-~a
6
7  =met exitValue=0
9 rem Iterate through the input file paths which are separated by ";°'
10 H TERATE_INPUTS
11 if "%inputsi"=—"" goteo EXIT
12 for /f "tokens=1 delims=;" %%a in ("%inputs%") do call :HANDLE INPUT "3%%a"
12 for /f "tokens=1* delims=;" %%z in ("%inputs%") do set inputs=%%ib
14 goto ITERATE INPUTS
15
16 :HANDLE_INPUT
17 echo Add code here to handle each input
| 8 goteo :eof
19
20 (EXIT
21 exit SexitValue$
22
Bat¢ length: 575 lines: 22 Ln:22 Col:1 S5el:0 Dos\Windows ANSI INS
|

2. You can modify the Script as shown below to duplicate the files to a specified output folder
with a size check. Save this code as a text file with . bat ' extension in the Script Runner
Batch File Folder (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile)
or in the Automation Engine 'BatchFile' folder.
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L/ CAEsko\bg_data_fastserversarunnt_v100\Scripts\Batch\myCopyloat - Notepad=+ (e () e
File Edit 5earch View Encoding Language Settings Macre Run  Pluging  Window 7 X
cHEHGB LB saD|loc|ihgl ¢tz BRI I1EDEEN®E 7
= myCopybat |
1 Gecho off
2 rem First script argument contains the input file paths
2 set inputs=%1
4 rem Trim surrounding quotes
3 for /f "usebackg tokens=*" %%a in ('%inputs%") do set inputs=%%~a
6
7 rem Get the output folder
8 =et outputFolder=%2
9
10 rem Get the maximum size from the script parameters
11 rem and convert from megabyte to bytes
12 set /a maxSize=%3*1000000
13
14 s=et exitValue=0
15
1& rem Iterate through the input file paths which are separated by ";"
17 : ITERATE INPUTS
18 if "%inputs%"=—"" goto EXIT
1% for /f "tokens=1 delims=;" %%a in ("%inputs%") do eall :HANDLE INPUT "%%a"
20 for /f "tokens=1* delims=;" %%z in ("%input=s%") do set inputs=%ib
21 gote ITERATE INFUTS
22
23 :HANDLE INPUT
24 rem Get the size of the input
25 for %%? in (%l) deo set inputSize=%%~z? 1]
26 rem Check wether the input is OE to copy
27 if %inputSize% lss ¥maxSize® (
28 rem Copy input to output folder
29 copy /v %1 %outputFeolder%
20 ) else |
31 echo %1 is too big to copy
3z set exitValue=1
33 )
24 goto :eof [
35
36 EXIT
37 exit %exitValue® I
28 |
4 Tt | 3
Bat¢ length: 973 lines: 38 Ln:38 Col:1 Sel:0 Dos\Windows ANSI INS
%1 First batch file argument: the Run Script task’s inputs. A string of input file paths,

separated by ;".

o\°

2 Second batch file argument or output folder: the folder where AE expects the

script’s result files. AE will continue the flow with the files you write in this folder.
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If you leave this folder empty, AE will continue the flow with the inputs of the Run
Script task.

%3, %4, Remaining batch file arguments: additional script parameters, injected into the

%5.. script via the Run Script task.

Exit Ending Status of the task

value

0 OK

1 Warning

2 Error

3. In a Pilot, go to Files view, select the files to be copied and open a New Task. Choose the
Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job's Script Output folder. In this
example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

Settings for Step: Run Script

Output in: |[Job URL]/ScriptQutput BROWSE W]
File Name:
2
Run on: | My Win Script Runner | & ]
Script Type: | Batch File o ]
Script File: myCopy.bat [1 j

Script Parameters

‘SmallLabel.pdf’ is duplicated into the job's 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning' state and added an entry in the
task details.
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80O

{a]ia)

¥ VIEWS

To Do List
@ Pages

EE Products

@ WebCenter

E Plates

[£] coi

Tasks
Milestones
11 Tickets

¥ TOOLS

|E| Devices

Queue Moni...

Files {(RunScriptDemo)

ri = +N Q-
¥ [u] RunScriptDemo View Size
» [ Arwork ) SmallLabel.pdf view 89KB o
» [ Esko E it
» [ ScriptOutput avorites
[=] - &3 » & RunScript = (] ScriptOQutput
File Name Task Type Progress Phase State Task ID
BigBox.pdf,SmallLabel. R pt_100 :
000 Details

Task Type: Run Seript
Started on Server: begezingem
Started at: 6/27/12 10:44 AM
Finished ar: 6/27/12 10:44 AM
Process Time: 0:00:00

The script's standard output stream:

"\\begezingem\MyJobContainer\RunScriptDemo\Artwork\BinBox.pdf is too big to copy

o | 1 file(s) copied.
+ | The script's error output stream:
<none:
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8. Using ExtendScript (Mac & Windows)

8.1. Adobe Applications on Windows: Run Script
Runner as an Application (Not as a Service)

8.2.

When you use ExtendScript on Windows, you can avoid troubles while accessing your user
specific settings such as Adobe applications' Presets , Actions etc. by stopping the Script
Runner service and running it as an application for the logged in user (who also defined
the Adobe settings).

Follow these steps to do this:
+ Open Start > All Programs > Esko > Automation Engine Script Runner > Preferences.

+ Stop the Script Runner and deselect Start at login (which actually means ‘Start as service’)
and Close Preferences.

« Startit as a console application by double clicking its executable in the Script

Runner’s program folder >\bin ix86\egscrrun.exe. For example C:\Esko
\bg prog fastserverscrrunnt v141\bin ix86\egscrrun.exe

ExtendScript in Adobe Illustrator - Example 1

ExtendScript is JavaScript extended for Adobe CS/CC applications. Adobe provides the
ExtendScript Toolkit (ESTK): a complete IDE (integrated development environment) to program
ExtendScript. Learn more about Adobe scripting resources in the Adobe Scripting Center.

1 Attention: As mentioned in the introduction, Adobe (Windows) 32 bit applications are
A no longer supported on a standalone Script Runner tool.

1. Open the ExtendScript Toolkit and add the below shown code. Save this code in the Script
Runner’s ExtendScript folder. The default location is : /Library/Scripts/Esko/ExtendScript
for a Script Runner on Mac or C:\Esko\bg _data_fastserverscrrunnt_v100\Scripts
\ExtendScript on Windows. Alternatively, you can save them in the ExtendScript folder of
Automation Engine.
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® * Sourcel
&3 [ Adope lustrator GS5.1 =] 123 P W >V A -;
1 function main (inputs, outputfolder, params}
2
3 T $.writeln ("Hello, World!");
4 alert ("Another way to say: Hello, Waorld!");
5 return "OK";
6 b
7 B
[ & -3 4|
| Line 7 Column 1
Main This function will be called by the Script Runner. Only the code in this
main function gets executed.
Inputs First argument of main function: a list of input file paths (type: list of
strings).
outputFolder Second argument of the main function: the folder where AE expects the
script’s result files. AE will continue the flow with the files you write in this
folder. If you leave this folder empty, AE will continue the flow with the
inputs of the Run Script task (type: string).
params Third argument of main function: additional script parameters, injected

into the script via the Run Script ticket (type: list of strings).

S.writeln

This writes extra log information in the Run Script task details and log.
Without Script Runner context this call prints text to the Console, and
adds a newline character.

alert

This registers some extra log info in the Run Script task details and log.
Without Script Runner context this call displays an alert box.

return “OK”;

This communicates to the Run Script task that everything went fine.
Other possibilities are Return = “Warning” and Return = “Error”.

2. To test the script locally in the ExtendScript Toolkit, add below shown code, save and run the

script.
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c

Adobe llustrator G85.1 main

function main (inputs, outputFolder, params)
{
$.writeln ("Hello, World!");
alert ("Another way to say: Hello, World!");
return "OK";
}

// Our main function is not using any of its arguments, so you can test main without arguments
main ();

=

RN

As a result, ‘Hello, World! and ‘OK’ are shown in the Console and the alert box pops up:

ASLRIFT LONSULE
Hello, Warld!
Result: OK

Another way to say: Hello, World!

oy

The Script Runner does not interpret the test code in your script. It will execute only the
contents of the main function and ignore the rest. You can keep your test code for future
local testing.

3. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.
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Settings for Step: Run Script

Output in: | 5]
File Name: ERaR
o

Runon: | My Mac Script Runner |3

Script Type: [ ExtendScript H

Application: |Adobe Illustrator ﬂ

Script File: | MyHelloWorld.jsx [1 o)

Script Parameters

+] -]

Note that the ‘Hello, World!" in the task details and ‘OK’ state are corresponding with
$.writeln("Hello World!™)and Return = “OK” in the script.

800 Tasks (RunScriptDemo)

= jobName _FileName  TaskType State

)| RunScriptDemo Blairon.pdf  Run Script  100% 6/4/12 2:11 PM 3788

To Do List

m Pages

Task Type: Run Script
Started on Server: begezingem
Started at: 6/4/12 2:11 PM
Finished at: 6/4/12 2:11 PM
Process Time: 0:00:01

| The script's standard output stream:
| Hello, World!

| Another way to say: Hello, World!
The script's error output stream:
<none>

E Plates
2] coi

Milestones
|| Tickets

T

Relaunch @ Move to History Delete
|_|_|=1 s | ¥} it .

36



ESKOS

Automation Engine

8.3. ExtendScript in Adobe lllustrator - Example 2

In this example we use ExtendScript to Open a file in Illustrator and print it using a Print
Preset.

Note: Make sure you read this page first: Adobe Applications on Windows: Run Script Runner as
an Application (Not as a Service) on page 33.

Note: To prevent having to start up the Script Runner every time you log in, add its executable
to your user’s/system’s Startup Items.

1. Define a My Print Preset in your Adobe lllustrator application.

2. Open the ExtendScript Toolkit and add the below shown code. This code is aimed to iterate
through the list of inputs. It enables you to handle the inputs one by one, via the input
variable.

=== | ExtandScript Toolkit CS5.5 ) [ main | B oy H > Y A =
1 function main(inputs, outputFolder, params)
2 =B
3 // Iterate through the list of inputs.
4 for (i=0; i<inputs.length; i++)
5 B {
6 var input = inputs[i];
7 // Add code here to handle each input.
8 }
9 |
10 return "OK";
11 -}
12
[ o —3 ERES

| ILina 12 Column 1

3. To print every input file using a Print Preset from the script parameters in the Run Script
task, write the code as shown below. Save this code in the default ExtendScript folder (of
Script Runner or of Automation Engine).
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c

ExtendScript Toolkit C85.5 main

function main{inputs, outputFolder, params)
=L
// First and only script parameter is the print preset.
var printPreset = params[0];

var returnValue = "OK";

// Tterate through the list of inputs.
for (i=0; i<inputs.length; i++)
=

var input = inputs[i];

try

= {

// Open the input file.

var myDocument = app.open{File{input), DocumentColorSpace.CMYK);
// Create print options and set the print preset.

var options = new PrintOptions();
options.printPreset = printPreset;

// Print the document,

myDocument.print(options);

// Close the document without saving.
myDocument.close(SaveOptions .DONOTSAVECHANGES);
i }

catch (e)

= {

// Log problem info and set the return value to "Warning".
$.writeln{"Problem while printing " + input);
$.writeln{"Name: " + e.name);

$.writeln{"Message: " + e.message);

returnValue = "Warning";

i }

}

return returnValue;

|
RN
N 1

4. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.
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Settings for Step: Run Script

.' Output in: [1
Qa File Name:
Run on: | My Mac Script Runner |5 ]
Script Type: | ExtendScript s ]
Application: Adobe lllustrator ﬂ
Script File: MyPrint.jsx [1 j

Script Parameters

Print Preset

I

Launching this ticket will print the selected Illustrator files using the Print Preset specified
as script parameters (My Print Preset)in the task.

8.4. ExtendScript in Adobe Photoshop - Example

Note:

Sample scripts are solely intended to demonstrate techniques for accomplishing common
tasks. Additional script logic and error-handling may need to be added to achieve the desired
results in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any
non-Esko products.

In this example, we illustrate a script that performs a Photoshop "action" and then
produces a JPEG output. The script 'EskoPSDoActionAndSaveas)PG.jsx' is available from the
sample scripts subfolder "ExtendScript" in /Library/Scripts/Esko (Mac) or C:\Esko
\bg data fastserverscrrunnt v100\Scripts (Windows).

1. You have to save the Set and Action in Photoshop. In this example we are using an action
named "Molten Lead" which is one of the "Default Actions" (folder) as Set (variable 2)
and "Molten Lead" as Action (variable 1).

2. You can open the script with ExtendScript Toolkit to edit the script if required. However, in
this sample, we do not need to edit the script.
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ExtendScript Toolkit G54 [ [ main = B u B » V¥V A

m |

=
* Sample scripts are provided as-is with ne warranty of fitness for a particular purpase.

* These scripts are solely intended te demenstrate techniques for accomplishing comman tashs.

* Additional script logic and error-handling may need to be added te achieve the desired results in your specific environment.

* Itis up to the user to verify that his intended use of the offered automation functionality is compliant with any third party license agreement and/or other
)

function main(inputs, cutputfolder, parmms)
{

E for (i=0;i<inputs.length;i++)

H{

var flleRef = new Flle{inputs[i1);
var docRef = app.open(fileRef);

app.doAction{parmms[0], parmms[1 ])d

outputFile = new File{outputFolder + “/" + fileRef.name);
jpgSaveOptions = new JPEGSaveOptions ();
jpgSaveOptions.embedColorProfile = true;
jpgSaveOptions.formatOptions = FormatOptions .STANDARDBASELINE;
jpgSaveOptions.matte = MatteType.NONE;
jpgSaveOptions.guality = 1;
docRef.saveAs (outputFile, jpgSaveOptions, true, Extension.LOWERCASE);
docRef.close (SaveOptions .DONOTSAVECHANGES);

H

return "OK"

-2

3. Edit the settings of the Run Script task as shown below:

Settings for Step: Run Script

" Qutput in:  [Job URL]/output [ BROWSE JI]
File Name
a
Run on: | ShaletMAC ﬂ

a)
v

Script Type: | ExtendScript

Application: Adobe Photoshaop CS3 L}

Script File: 'EskoPSDoAcr‘sonAndSaveAsJPC‘jsx [l 3

Script Parameters
Molten Lead
Default Actions

+

a) Run on: is the name of the computer where your Automation Engine ScriptRunner is
installed. The name in this example is ShaletMac. Learn more about configuring and
naming a Script Runner in Configuring Script Runner on page 7.

b) Script Type: choose ExtendScript.

¢) Script File: choose EskoPSDoActionAndSaveasJPG. jsx.

d) Script Parameters: Add the name of your Photoshop Action name followed by your
Set. In this example, Molten Lead; Default Actions

e) Save the task ticket.
4. Launch the task:
a) Select a Photoshop file.
b) Right-click the file and browse for the ticket.
¢) Click Launch.

You will see that while the script starts to run on the Automation Engine server, Photoshop
opens, performs the actions, closes and continues the script. The result of this sample script
is an adjusted JPEG file.
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9. Script Samples

Click this link to download a PDF containing some samples of scripts.

Automation Engine
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